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Abstract 
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This protocol was validated in: eLife (2021), DOI: 10.7554/eLife.68424 
 

Polarized actin cables in S. cerevisiae are linear bundles of crosslinked actin filaments that are assembled by two 
formins, Bnr1 (localized to the bud neck), and Bni1 (localized to the bud tip). Actin is polymerized at these two 
sites, which results in cables extending along the cell cortex toward the back of the mother cell. These cables serve 
as polarized tracks for myosin-based transport of secretory vesicles and other cargo, from the mother cell to the 
growing daughter cell. Until recently, descriptions of actin cable morphology and architecture have largely been 
qualitative or descriptive in nature. Here, we introduce a new quantitative method that enables more precise 
characterization of actin cable length. This technological advance generates quantitative datasets that can be used to 
determine the contributions of different actin regulatory proteins to the maintenance of cable architecture, and to 
assess how different pharmacological agents affect cable arrays. Additionally, these datasets can be used to test 
theoretical models, and be compared to results from computational simulations of actin assembly. 
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Graphical abstract: 
 
 

 
 
Illustration of actin cable length and morphology analysis.  
(A) Representative maximum intensity projection image of S. cerevisiae fixed and stained with fluorescently-
conjugated phalloidin to label F-actin (displayed in color), and fluorescently-conjugated Concanavalin A to label 
the cell wall (displayed in grey scale). Lengths of actin cables traced from the bud neck to their ends are indicated 
(dashed lines). (B) Inverted grey scale image of F-actin labelled with fluorescently-conjugated phalloidin and the 
cell wall traced in black. The length (purple) and end-to-end distance (green) of a single actin cable is indicated. 
Scale bar, 2 µm. (C–E) Actin cable length (C), end-to-end distance (D), and tortuosity (E) from hypothetical datasets, 
where each data point represents an individual cable and larger symbols represent the mean from each hypothetical 
experiment. Error bars, 95% confidence intervals. 
 
 

Background 
 
Cells build micron-scale cytoskeletal arrays that have precise, yet diverse sizes, shapes, and dynamics tailored to 
their biological roles. This is achieved through tight cellular control over the assembly, disassembly, and 
organization of the cytoskeletal polymers; however, the mechanisms underlying this control remain poorly 
understood (Mohapatra et al., 2016). The polarized array of actin cables found in budding yeast provide an excellent 
model system for investigating cytoskeletal length control mechanisms, because the cables grow to a defined length 
and can be easily labeled with bright fluorescent dyes, to enable visualization via light microscopy (Eskin et al., 
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2016). The yeast actin cables are assembled by two formins (Bnr1 localized at the bud neck, and Bni1 localized at 
the bud tip), and rapidly grow from these sites into the mother cell, to serve as tracks for myosin-based intracellular 
transport (Pruyne et al., 2004; Moseley et al., 2006). As they are assembled, actin cables become decorated with 
tropomyosin, which antagonizes disassembly factors, to allow cables to grow long and reach the back of the cell. 
Thus, cables are highly dynamic structures, which are rapidly polymerized by formins at their barbed ends (bud tip 
and neck), and subsequently disassembled by cofilin and other factors. Therefore, cable length is determined by a 
balance between these two simultaneous competing effects (McInally et al., 2021).  
  Until now, the majority of studies on actin cable morphology have been qualitative in nature, with a few 
exceptions where cable lengths and tortuosity were measured (Eskin et al., 2016; McInally et al., 2021). Here, we 
have expanded on these efforts and developed an improved quantitative method, to more precisely measure cable 
lengths and morphology in the mother cell compartment. This method generates datasets that can be used to 
determine how various actin regulators contribute to the control over actin cable length and morphology. 
Furthermore, these datasets can be used to test theoretical models of actin cable length control, as well as compared 
with results from computational simulations of actin cable assembly.   
 
 

Materials and Reagents 
 
1. Styrofoam container 
2. 2 L flask 
3. 1.7 mL Eppendorf tube (Denville, Posi-Click Tubes, catalog number: C2170) 
4. Microscope cover glass (ThermoFisher Scientific, 22 mm × 22 mm-1.5, catalog number: 12541B) 
5. Microscope slides (VWR Vistavision, 3” × 1” × 1mm, catalog number: 16004-430) 
6. Glass culture tube (VWR, catalog number: 10545-946) 
7. Saccharomyces cerevisiae grown to mid-log phase (NCBITaxon:4932) 
8. Formaldehyde, 37% by weight (Fisher Chemical, catalog number: F79500) 
9. Alexa Fluor 488-phalloidin or Alexa Fluor 568-phalloidin (Life Technologies, catalog number: A12379, 

A12380) 
10. Antifade mounting media (Vectashield, catalog number: H-1000)  
11. Yeast extract peptone dextrose media (see Recipes) 
12. Phosphate buffered saline (see Recipes) 
 
 

Equipment 
 
1. Table-top centrifuge (Labnet Prism R Refrigerated Microcentrifuge, catalog number: C2500-R) 
2. Cell culture roller drum (Fisher Scientific, catalog number: 1640FS) 
3. NanoDrop spectrophotometer, with cuvette capability (ThermoFisher Scientific, catalog number: ND-2000C) 
4. Hematology/Chemistry Mixer (Fisher Scientific, catalog number: 346) 
5. Confocal microscope (Carl Zeiss, model: LSM 880 with Airyscan) 
6. Objectives (Carl Zeiss, 63×/1.4 Plan-Apochromat Oil objective lens) 
 
 

Software  
 
1. Zen Black Software (Carl Zeiss)  
2. ImageJ (Plug-in supplemented version: Fiji): https://imagej.net/software/fiji/  
3. ImageJ/FIJI macros to facilitate image processing are available on GitHub: https://github.com/shanemc11/bio-

protocol 
4. Anaconda Python (https://www.anaconda.com/) 
5. Python scripts used for data analysis available on GitHub: https://github.com/shanemc11/bio-protocol 
 

https://imagej.net/software/fiji/
https://github.com/shanemc11/bio-protocol
https://github.com/shanemc11/bio-protocol
https://www.anaconda.com/
https://github.com/shanemc11/bio-protocol
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Procedure 
 
A. Yeast cell culture 

 
1. Remove yeast glycerol stock from -80°C freezer and place in Styrofoam™ container containing a small 

amount of dry ice. 
2. Streak out a small amount of the glycerol stock onto a YPD agar plate. 
3. Incubate at 25°C for 3–5 days, until single yeast colonies appear on plate. 
4. Use a single colony to inoculate a 5-mL liquid culture of YPD media.  

Optional: To ensure you have a culture at the appropriate density the next day, one can set up multiple 
culture tubes the night before, each at a different dilution of cells.  

5. Incubate on a cell culture roller drum at 25°C for 16–18 h. 
6. Check cell density using a spectrophotometer, to determine if culture has reached mid log-phase growth 

(OD600 ~0.3). 
 
B. Cell fixation and phalloidin staining 

 
1. Starting from a 37% formaldehyde stock, add a final concentration of 4.4% formaldehyde to cells, vortex, 

and incubate on the cell culture roller drum at 25°C for 45 min. 
Note: If fixing 5 mL of cell culture, use 595 µL of 37% formaldehyde. We recommend fixing the entire 5 
mL culture, to avoid possibly physically stressing the cells during pipetting. 

2. Add 1 mL of fixed cells to a labelled 1.7-mL Eppendorf tube. 
Note: The remaining 4 mL of fixed cell culture can be washed, and stored at 4°C for later use. 

3. Pellet cells in a microcentrifuge (9,500 × g for 30 s). 
4. Decant supernatant, and add 500 µL of 1× PBS. Invert tube to resuspend pelleted cells. 
5. Repeat steps 3–4 two more times, to wash cells. 
6. After final wash, resuspend cells in ~50 µL of 1× PBS. 
7. Add 3 µL of 6.6 µM Alexa Fluor 488-phalloidin or Alexa Fluor 568-phalloidin to a final concentration of 

~0.4 µM (~1:16 dilution). 
8. Mix via pipetting. 
9. Incubate on a rotator or rocker to gently mix the sample at room temperature for a minimum of 4 h (or 

longer periods at 4°C). 
10. Wash cells with 500 µL of 1× PBS, re-pellet as above (step B3), and resuspend in ~20 µL of 1× PBS.  

Optional: To improve detection of the bud neck area during image analysis, label cell wall with 
fluorescently-conjugated Concanavalin A (Okada and Ohya, 2016). For details see Okada and Ohya 
(2016).  

 
C. Cell mounting and imaging 

 
1. Clean microscope slide with 70% ethanol and KimWipe. 
2. Add 1 µL of stained cells to the center of the microscope slide. 
3. Add 1 µL of Vectashield (or other mounting media) to stained cells, and mix via pipetting. 
4. Add a 22 mm × 22 mm -1.5 coverslip on top.  

Note: The cell/mounting media suspension should spread to the edges of the coverslip. If it doesn’t, cells 
are likely to drift during imaging, making them unsuitable for analysis. 

5. Mount slide on microscope, and bring cells into focus using a 63×/1.4 Plan-Apochromat Oil objective lens. 
Note: The above objective lens is what we regularly use; however, other objective lenses (with a similar 
numerical aperture) should be suitable.  

6. Adjust acquisition settings for your specific microscope (laser power, exposure time, etc.), to acquire 
images with suitable dynamic range for quantification. It is necessary to empirically determine the optimal 
acquisition parameters for your microscope and sample. See Figure 1 for example acquisition parameters 
using a Zeiss 880 LSM with Airyscan.  



Cite as: McInally, S. G. et al. (2022). Quantitative Analysis of Actin Cable Length in Yeast. Bio-protocol 12(09): e4402. DOI: 
10.21769/BioProtoc.4402. 

 

5 
 

 

Published:  May 05, 2022 

Note: While not necessary, we generally use super-resolution microscopy [e.g., structured illumination 
microscopy (SIM) or Airyscan] for image acquisition, as these imaging modalities produce superior detail 
in actin cable architecture. 

7. Acquire z-series images so that the entire volume of the cell(s) is captured in the stack. 
Note: The number of frames in the z-dimension required to capture the entire volume of the cell will depend 
on the size of the cells you are imaging. A typical haploid yeast cell will require approximately 30 frames 
acquired at 200 nm intervals. 
 
 

 
 
Figure 1. Example acquisition parameters for imaging phalloidin stained actin cables using a Zeiss 880 
LSM with Airyscan.  
(A) Typical Acquisition Mode settings in Zen Black software used during imaging, to generate high quality 
super-resolution images of actin cables. (B) Settings used for the 488-laser channel, to image actin cables 
stained with Alexa Fluor 488-phalloidin.   

 
 

Data analysis 
 
1. Open ImageJ/FIJI and the folder containing the z-series images acquired above. 
2. To speed up the analysis and eliminate repetitive steps in image processing, we recommend using macros to 

automate the generation of maximum intensity projections, and to generate inverted grey scale z-series images. 
Note: Two such macros (available here: https://github.com/shanemc11/bio-protocol) are “MIP_macr.ijm” and 
“invert_macr.ijm”; they generate maximum intensity projections and inverted grey scale versions of the z-
series images, respectively. There are many resources (e.g., https://forum.image.sc/) explaining how to further 
edit and customize these macros.  

3. Open an inverted grey scale z-series image, along with the maximum intensity projection of the same image in 
ImageJ/FIJI. 

https://github.com/shanemc11/bio-protocol
https://forum.image.sc/
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4. Adjust the brightness and contrast (FIJI>Image>Adjust>Brightness/Contrast) of the maximum intensity 
projection image, to identify cells with brightly labelled actin cables. 

5. Once an appropriate cell is identified, locate the same cell in the inverted grey scale z-series, and similarly 
adjust the brightness and contrast. 

6. Synchronize the two images using the Synchronize Windows tool in FIJI (FIJI>Analyze> Tools>Synchronize 
Windows; click ‘Synchronize All’ in the window that opens). 

7. Select the segmented line tool from the FIJI toolbar, and draw a straight line perpendicular to the bud neck. 
Add the annotation to the images using ‘Add Selection’ (FIJI>Image> Overlay>Add Selection; alternatively 
use Crtl+B). This line will delineate the ‘start’ position for the cables that will be traced from this cell. 
Note: If you have labelled the cell wall using fluorescently-conjugated Concanavalin A, switch to this image 
channel, and draw a straight line perpendicular to the narrowest region of the bud neck. 

8. Scroll through the inverted grey scale z-series and identify actin cables that clearly emerge from the bud neck 
and extend into the mother cell. To trace each cable, use the segmented line tool (first double click the line tool 
icon in the toolbar, and then select ‘Spline fit’ in the Line Width window). Start from the line drawn at the bud 
neck, and click to extend the line along the cable. As cables are likely to intersect with other cables and/or 
patches, you will need to scroll through the inverted grey scale image, to ensure that you are accurately tracing 
the same cable. Additionally, the maximum intensity projection can help with this. 

9. Once the entire cable has been traced, right-click the final tracing point, to terminate the annotation of the image. 
10. Save the coordinates of the trace as a text file of XY-coordinates (FIJI>File>Save As>XY Coordinates). It is 

recommended to assign a shortcut key for this step using ‘Add Shortcut’ (FIJI>Plugins>Shortcuts>Add 
Shortcut). 

11. Repeat steps 3–10 for all possible cells, from all of the images acquired. 
12. Download ‘actin_cable_length_analysis.py’ from GitHub, and open using Anaconda. 
13. Indicate the directory where the text files of XY-coordinates are located, and run the script. 

Note: This python script will calculate cable length and cable tortuosity (i.e., the ratio of the cable length to 
the ‘end-to-end’ distance of the cable), and output these calculations as a .csv file into the indicated output 
directory.  

14. Download ‘actin_cable_length_plots.py’ from GitHub, and open using Anaconda. 
15. Indicate the directory and filename of the .csv file from the output of Step 13. Indicate also the output directory 

and filenames for the plots that will be generated in the next step. 
16. Run the script. 

Note: This python script will generate plots of actin cable length, the end-to-end distance of the cables, and 
cable tortuosity (see Graphical Abstract for examples). These plots follow the ‘SuperPlot’ style (Lord et al., 
2020), and are intended to compare the above measurements between different yeast strains or different 
treatments (e.g., pharmacological) from multiple experimental replicates. We have successfully used this 
method to measure differences in actin cable length during changes to cell size, and in smy1∆ mutants (Eskin 
et al., 2016; McInally et al., 2021). Additionally, we have used this method to detect significant changes in 
cable tortuosity for bud14∆, and smy1∆ mutants (Eskin et al., 2016).  
 
 

Recipes 
 
1. Yeast extract peptone dextrose media 

a. Combine the following in a 2-L flask 
20 g Peptone Y 
10 g Yeast extract 
20 g Agar 
0.15 g L-tryptophan 
900 mL of ddH2O 

b. Autoclave this mixture on the liquid cycle for 25 min. 
c. Allow media to cool, while continuously stirring on a stir-plate. 
d. Add 100 mL of sterilized 20% glucose (bringing final concentration to 2%), and mix on stir-plate for 

another minute, before pouring plates. 
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2. 10× Phosphate buffered saline (PBS) 

a. Combine the following in a 3-L beaker 
320 g NaCl  
8 g KCl 
71.2 g Na2HPO4·2H2O 
9.6 g KH2PO4 

b. Mix salts together, and dissolve in 2 L of ddH2O.  
c. When dissolved, aliquot 500 mL into each of four 1-L glass bottles.  
d. Add 500 mL of ddH2O to each bottle, bringing volume to 1 L. 
e. This 10× PBS stock should be diluted to 1× with ddH2O before use. 
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